Colleague/Datatel
Tutorial for New Faculty

Compiled and Presented by
HCC Management Information Systems
Maridru Clark and Terri Rogal
Index

Logging on to Colleague/Datatel..............................................................................2

Keyboard Shortcuts..............................................................................................4

Common Faculty Inquiries and Reports.................................................................2

1. TRCL..................................................................................................................5
2. TSUM.................................................................................................................7
3. SPRO..................................................................................................................9
4. LOCR...............................................................................................................12
5. FWKL.............................................................................................................14
6. FGRN.............................................................................................................17
7. SROS.............................................................................................................18
8. SPRT.............................................................................................................23
9. RQMM...........................................................................................................27
10. OFFI............................................................................................................32
11. FAOHI.........................................................................................................33
12. XFSD............................................................................................................35
Logging Into Colleague/Datatel

Double click on the Datatel icon.

Enter your User ID and password. Click OK.

For this workshop only:
User ID:
Password:

The Datatel screen will appear.

If the ST folder is not showing, click APPS on the toolbar and switch to ST.
# Keyboard Shortcuts

Here are some commonly used keyboard shortcuts for those of you who do not “mouse” around:

<table>
<thead>
<tr>
<th>COMMONLY USED KEYBOARD SHORTCUTS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(alternative keystroke combinations separated by</td>
<td>)</td>
</tr>
<tr>
<td>Move to the next field</td>
<td>Tab</td>
</tr>
<tr>
<td>Move to the previous field</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Move forward one row</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Move back one row</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Move forward one screen</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move backward one screen</td>
<td>Page Down</td>
</tr>
<tr>
<td>Move to the beginning of the current field</td>
<td>Home</td>
</tr>
<tr>
<td>Move to the end of the current field</td>
<td>End</td>
</tr>
<tr>
<td>Move to the first row of a window</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>Move to the last row of a window</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>Field insert</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Field delete</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Open the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Cancel</td>
<td>Alt+F, C</td>
</tr>
<tr>
<td>Save [Update]</td>
<td>Alt+F, S</td>
</tr>
<tr>
<td>Close [Finish]</td>
<td>Alt+F, L</td>
</tr>
<tr>
<td>Detail</td>
<td>Alt+F, D</td>
</tr>
<tr>
<td>Direct Access</td>
<td>Alt+F, A</td>
</tr>
<tr>
<td>Record Delete</td>
<td>Alt+F, R</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F, X</td>
</tr>
<tr>
<td>Open the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Open the Apps menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Open the Help menu</td>
<td>Alt+H</td>
</tr>
<tr>
<td>Field Help</td>
<td>Alt+H, F</td>
</tr>
<tr>
<td>Process Help</td>
<td>Alt+H, P</td>
</tr>
<tr>
<td>Keyboard Shortcut Help</td>
<td>Alt+H, U</td>
</tr>
<tr>
<td>Pull down the Favorites menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Pull down the Options menu</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Pull down the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>
Common Faculty Screens

These common screens are accessible to faculty. Examples of each screen are on the following pages. Each screen can be accessed by either using the drop down menus, or by simply entering the mnemonic (Quick Access) in the toolbar.

Inquiry Screens

1) TRCL – student transcript information (courses taken, grades, etc)
   TRCL-Transcript Course Listing

2) TSUM - Student test scores (CPT, SAT, ACT, etc).
   TSUM-Test Summary

3) SPRO - Student Profile (address, GPA, current schedule, etc)
   SPRO-Student Profile

4) LOCR - Student Locater (class schedule on a given day)
   LOCR-Student Locator

5) FWKL – Faculty Workload (shows section numbers, points)
   FWKL-Faculty Workload

6) FGRN – Final Grading by Name
   FGRN-Final Grading by Name

7) FAOH – Faculty Office Hours
   FAOH-Faculty Office Hours

8) OFFI – Person’s Office Information (under the HR system)
   OFFI-Person’s Office Information

Report Screens

1. SROS - Section Roster
   SROS-Section Roster

2. SPRT - Section Prerequisite Roster
   SPRT-Section Prerequisite Roster

3. RQMM – Requisite Mismatch Report
   RQMM-Requisite Mismatch

4. XFSD – Faculty’s Schedule
   XFSD-Faculty Schedules

Common Keystrokes

1. F10 - Finish Key (returns you to the last screen or menu)

2. F9 - Returns you to the same blank screen
TRCL: Transcript Course Listing

Use the Transcript Course Listing (TRCL) screen to view academic transcripts. The TRCL screen displays a list of all of the student's courses and the associated: grades earned; attempted; credits completed; credit calculated; academic term.

In the Mnemonic box, enter TRCL. Press enter or click the Go button.

Enter the student's name, SSN, or ID. Click OK or press enter.

If you choose to enter a name, a resolution screen will appear and let you pick which student you would like to look at. Enter the number to the left, check the box to the left or enter the number to left in the text area on the bottom. You may click the blue disc or press the Enter button on your keyboard.

For Undergraduate Transcripts, enter UG. Other transcript groupings exist, such as CE, PSAV, ABE, EPI EGAA and UGAS, but are not used as often as UG. Click OK or enter.
The TRCL screen will be displayed.

Note: Courses with no section numbers are transfer credit from another institution or courses converted from our legacy administrative system.

If you want to look at another student, press F10 (save and update), and press enter on your keyboard or the Update button on the screen.

When you are finished using the TRCL screen, press F9 (save and update) and you will be taken to the home Colleague menu.
**TSUM: Test Summary**

Givens test scores (CPT, ACT, SAT, etc) for a particular student.

In the mnemonic (Quick Access) text box, enter TSUM. Press enter.

Enter the student’s name, SSN, or ID. Click OK or press enter.

If you choose to enter a name, a resolution screen will appear. Pick the student you need. Enter a checkmark in the box to the left or enter the line number to left in the text area near the bottom. You may click the blue disc or press the enter button on your keyboard.

The Test Summary screen will display.

Scroll down as needed to view more scores.
Click the detail icon to display the NEQV screen for that student.

This screen gives more of the information you need to use for the student.
If you want to look at another student, press F10 (save), then enter or the Update button.

When you are finished with TRCL, press F9.
SPRO: Student Profile
Displays student information, such as address, phone, GPA, class locator.

In the (Quick Access) mnemonic text box, enter SPRO. Press enter or click the green Go button.

A blank Student Profile screen will be displayed along with a Student Lookup alert window.

Enter the student’s name, SSN, or ID. Click OK or press enter.
The populated Student Profile screen will be displayed on your monitor.

Clicking on any blue detail icon will give you additional information on a student. Some of the information available as in the screenshot above includes:

- Preferred Mailing Address
- Preferred Residence
- Academic Program(s)
- Academic Level
- Enrollment Status
- Status Date
- Completion Date
- Home Location or Campus
- Advisors

If you click on any of the following blue detail icons, separate screen with more information will appear.
Some helpful ones are:

- Terms student has attended
- Transcripts (coursework and GPA)
- Locator (student’s schedule on a given day)
- Demographics (several options appearing in a separate drop menu box as shown below)

When you are done, press F10 (and then the Update button to finish and return to the previous screen and/or access another student's information)

Another option is to Press F9 and then the Update button to save anything you may have done and return to the main Colleague menu.
**LOCR: Student Locator**
Find a student (by class, room, time) on a given day.

In the Quick Access field (mnemonic box), enter LOCR. Press enter on your keyboard or the green Go button.

![Quick Access LOCR Go](image)

On the Student LookUp window, enter the student’s name, SSN, or ID. Click OK or press enter.

![Student LookUp](image)

If you have entered the name of the student instead of the ID, a resolution screen will display with all the available choices. Select the student and enter the number to the left of that name in the text box below – or place a checkmark in the box next to the name and press the blue disc icon next to the red “X” to bring up the Locator screen. See the screenshot below (with the student’s information blocked out)
An information window will appear that asks on what day you would like to find where the student is. It will be populated with today’s date (as shown below).

The Student Locator screen will be displayed

When you are done, press F10 (and then the Update button to finish and return to the previous screen and/or access another student’s information)

Another option is to Press F9 and then the Update button to save anything you may have done and return to the main Colleague menu.
In the mnemonic box, enter FWKL. Press enter.

If you have entered the name of the faculty member instead of their ID, a resolution screen will display with all the available choices. Pick out the name that matches your needs and enter the number to the left of that name in the text box below – or place a checkmark in the box next to the name and press the blue disc icon next to the red “X” to bring up the Locator screen. See the screenshot below (with the faculty member’s information blocked out)
Enter the term in the start date field (i.e., 05/FA). Scroll down as needed for additional courses.

The FCSI mnemonic (Faculty Schedule Inquiry) as shown below is similar, but instead gives faculty schedule including times and rooms. *The term information (entered in the state date field) must be entered to display course section assignments accurately.*
When you are done, press F10 (and then the Update button to finish and return to the previous screen and/or access another classes’ information)

Another option is to Press F9 and then the Update button to save anything you may have done and return to the main Colleague menu.
**FGRN: Final Grading by Name**

Shows final grades for a given section.

In the mnemonic box, enter FGRN. Press enter.

Enter a forward slash (/), followed by the section number. Click OK or press enter.

The Final Grading by Name screen will display.

If you have used the Hawknet Web system to grade your classes, there will be a notation of that in a textbox at the bottom of the screen. The screenshot below is a sample of a class held last semester where the confidential info has been blocked out.

When you are done, press F10 (and then the Update button to finish and return to the previous screen and/or access another classes’ information. Another option is to Press F9 and then the Update button to save anything you may have done and return to the main Colleague menu.
## SROS: Section Roster

SROS can produce all the following variations: a single section roster, all section rosters for a particular faculty member, all roster by course name, section number, location and/or term.

In the Quick Access (mnemonic) box, enter SROS. Press enter on your keyboard or the green Go button.

**Make sure you do not enter too much information – you won’t get any results!**

Ask the questions: What do I want? One section? All sections of one course? Everything I teach?

This will be true for most reports. Start at the end and work your way back to what you ask the system to do.
For the sample used here, we enter only the Term in format: YY/FA (fall), YY/SP (spring) or YY/SU (summer) (Note: Entering and ellipses “…” will list all available terms from which to choose)

We entered the faculty member’s name (you will be prompted to select the correct faculty from a list on the resolution screen)

Press F10 (save) and press Enter on your keyboard or click the Update button to proceed.

The Section Roster screen will display. There is no input here. Press F10 (save) and enter to go on to the display choices

To view the report on the screen, select output device from a list in a drop down box. “H” to hold/browse the output.
Press F10 (save) and enter on your keyboard or click the Update button to proceed.

To print on a network printer choose the Output device: “P”  
Printer: “…” and enter for list. Contact your dept staff for correct printer name.

Always select the “c” mode (condensed-to print properly)

No input here. Press F10 and enter to proceed. Press your Enter key or click on the Update button to continue.
You will be presented with print job ID screen. Press F10 again or the blue Save icon in your toolbar and then the Update button in the alert box.

Wait until report processes (this may take a couple minutes). Press return to continue. You will be returned to the main Colleague menu.

If you used the Hold (H) option, the report window will show your report. If you used the Print (P) option, the report will directly to the network printer.

You may also use the task bar to print locally (your office) or remote (on the network). The network printers are capable of the condensed print you see in the window.
<table>
<thead>
<tr>
<th>ID</th>
<th>Student Name</th>
<th>Spec</th>
<th>Credits/CEUs</th>
<th>Level</th>
<th>Taken</th>
<th>Class</th>
<th>Acad Program</th>
<th>Admit Stat</th>
<th>Cmpl Rpt</th>
<th>Acad Add/Drop</th>
<th>Cr</th>
<th>Withdraw Drop</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td></td>
<td>3.00 cr</td>
<td>UG</td>
<td>AA.CIS.ANA</td>
<td>04/08</td>
<td>New</td>
<td>12/02/04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>02</td>
<td></td>
<td>3.00 cr</td>
<td>UG</td>
<td>AS.COP</td>
<td>05/09</td>
<td>Add</td>
<td>01/11/05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03</td>
<td></td>
<td>3.00 cr</td>
<td>UG</td>
<td>AA.MMC</td>
<td>05/07</td>
<td>Yes</td>
<td>12/21/04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>04</td>
<td></td>
<td>3.00 cr</td>
<td>UG</td>
<td>AA.LA</td>
<td>01/09</td>
<td>Add</td>
<td>01/12/05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05</td>
<td></td>
<td>3.00 cr</td>
<td>UG</td>
<td>FTIC</td>
<td>02/09</td>
<td>Yes</td>
<td>01/04/05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06</td>
<td></td>
<td>3.00 cr</td>
<td>UG</td>
<td>AS.WEB.TECH.OPTI</td>
<td>02/06</td>
<td>New</td>
<td>01/03/05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>07</td>
<td></td>
<td>3.00 cr</td>
<td>UG</td>
<td>AA.LA</td>
<td>02/09</td>
<td>Add</td>
<td>02/16/05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7 Students currently enrolled
SPRT: Section Prerequisite Report
Shows student’s prerequisite status for a given section or for all sections for a given faculty member.

In the Mnemonic box, enter SPRT. Press enter.

Enter Term in format: YY/FA or YY/SP or YY/SU
(Note: Entering “…” will list all available terms to choose from)

Enter faculty name (you will be prompted to select the correct faculty from a list)

Press F10 (save) and then either the Enter button on your keyboard or click the Update button on the pop up window that opened to proceed.

To view report on the screen, select output device: “H” to hold/browse the output.
Press F10 and enter to proceed.

To print on a network printer, in the Output device box, enter a “P” Printer: “… and enter for list. Contact your dept staff for correct printer name.

Always select the “c” mode (condensed-to print properly)

No input here. Press F10 and enter to proceed. Press your Enter key or click on the Update button to continue.
You will be presented with print job ID screen. Press F10 again or the blue Save icon in your toolbar and then the Update button in the alert box.

If you used the Hold (H) option, the report window will show your report.
If you used the Print (P) option, the report will go directly to the network printer.

You may also use the task bar to print locally (your office) or remote (on the network). The network printers are capable of the condensed print you see in the window.

If the “Close automatically…” box is checked, this message will not appear for very long.
Note: Prerequisite Status Codes: C (Complete)  I (In progress)  N (Not Started)  P (Pending)

A status code of C (complete) only indicates that a student has taken the prerequisite, not that they received a passing grade. A status code of N (not started) may be inaccurate if the student is USF cross-enrolled or college transcripts from another institution have not yet been entered into Datatel.
RQMM: Requisite Mismatch Report

Gives an indication what students may be missing in a prerequisite for a given course.

In the Quick Access (mnemonic) box, enter RQMM. Press enter on your keyboard or click the green Go button.

Press the Enter button on your keyboard or the green Go button to continue.

Enter a “Y” or the word Yes in the top three boxes:
- Print Prerequisites;
- Print Corequisites;
- Sort by Course

Go to the Course Section window area and enter the section number preceded by a forward slash. The resolution screen will be displayed with choices for you to make. (You will be prompted to select the correct section from a list of those that match your criteria)
The Requisite Mismatch box will be displayed, but you must answer an alert box before the report is printed. Click the Update button or just press the Enter key.

To look at (hold/browse the output) the report on your monitor, choose the “H” on the Output Device line:

Press F10 (save) or the Save icon, and press enter on your keyboard or click the Update button to proceed.
To print on a network printer, in the Output device box, enter a “P” Printer: “…,” and enter for list. Contact your dept staff for correct printer name.

No input here. Press F10 and enter to proceed. Press your Enter key or click on the Update button to continue.

You will be presented with print job ID screen. Press F10 again or the blue Save icon in your toolbar and then the Update button in the alert box.

Wait until report processes (this may take a couple minutes).
If you used the Hold (H) option, the report window will show your report.

You will get the following information window about the process:

![Requisite Mismatch Window]

If you click the “Close automatically…” checkbox you will see this window for a very short time and not have to click the FINISH button.

If you used the Print (P) option, the report will be sent directly to the network printer.

You may also use the task bar to print locally (your office) or remote (on the network). The network printers are capable of the condensed print you see in the window.

Wait until report processes (this may take a couple minutes). Press return to continue.
If you used the Hold (H) option, the report window will show your report. If you used the Print (P) option, the report will to directly to the network printer.

You may also use the task bar to print locally (your office) or remote (on the network). The network printers are capable of the condensed print you see in the window.

Note: You may use the TRCL inquiry to look at the student’s complete transcripts.
Creating Faculty Schedules using FAOH and XFSD

- Login to Colleague/Datatel as you normally would.

The XFSD report was designed to incorporate faculty office information, faculty office hours and faculty schedule information from Colleague, for a given term.

- Verify that the faculty office information is correct.

Access the OFFI (Office Information) screen in the HR application by switching from ST (Student) to HR (Human Resources). Click on Apps menu and select HR. **Remember that the information on the OFFI screen is maintained by HR and/or the Academic Deans’ staff. You cannot personally update this info.**

- Enter the Quick Access (mnemonic) OFFI in the task bar and click the Go button or press the Enter key on your keyboard to continue.

You will be asked which faculty member you would like to look at with the HR Person LookUp window. Enter their ID, SSN or Name. If you enter the name only, you will be given a resolution screen to pick the one you need.

- Update the following fields if the information on OFFI is missing or incorrect:
• Update to save (F10 or click the blue Save icon) the changes and return to the Student application by going back to the APPs menu and choosing ST.

You will be given a Faculty LookUp window. Enter the faculty member’s ID, SSN or name to continue.
Update the following fields:

- Start Date (To display the standard term start/end dates, key in the term, 03/SP, for example, in the Start Date field; the system will populate both start/end dates with the term dates automatically.)
- End Date (if term is not keyed in the start date field)
- Building (key in ONLN for Online office hours)
- Room (key in ONLN for Online office hours)
- Start Time
- End Time
- Days of Week (The system will populate the Freq field with “W”.)

**Note:** Faculty office hours must be retained in the system for three years. When entering additional office hours for subsequent terms, **DO NOT delete the previous office hours.**

To insert a line to key in the current term information if there are office hours posted for previous terms click on the first button (1), select *insert.*
You will be given a newly inserted line with which to add more info

<table>
<thead>
<tr>
<th>Start Date</th>
<th>End Date</th>
<th>Bldg</th>
<th>Room</th>
<th>Start Time</th>
<th>End Time</th>
<th>Days of Week</th>
<th>Freq</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/01/05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05/16/05</td>
<td>06/27/05</td>
<td>YASP</td>
<td>112</td>
<td>05:00PM</td>
<td>06:00PM</td>
<td>MW</td>
<td>W</td>
</tr>
</tbody>
</table>

- If you have made any changes or inserted additional lines, you must enter a <Y> (Yes) in the Rebuild Office Dates field.

- Update/Save the information and return to the menu by clicking the blue Save icon in the toolbar, or the F10 button on your keyboard. Press the Enter button on your keyboard or click on the Update button in the Alert window.

- Access the XFSD report screen by typing XFSD in the mnemonic field in the toolbar. Click the green Go button or press the Enter key on your keyboard.

- Update the Term information and key in the faculty information (faculty can be entered by Home Location {campus} or by entering individual faculty member's, names, SSNs or system IDs.)

- Update and proceed as with any Colleague report.
You may choose to see the paper report version by choosing a network printer or see all the schedules right on your monitor – which can be printed individually.
Click the Save icon on the toolbar or press your Enter key. The Faculty Schedules Report will start processing. If you do not place a checkmark in the “Close automatically when complete” box, you will get a message like this after all the records have been processed. In this case you must press the Finish button to get the report. The window will disappear when complete if the box is checked.

This will show each report you have chosen as a separate page on your monitor in the Report Browser.

If you have chosen to print more than one schedule, you can navigate from one to the other by clicking on the blue directional arrows on the browser’s toolbar.

When you choose to print one or more schedules, all you need to do is click the leftmost printer icon on the toolbar. The one on the right will take you back to setting up a print job on a network printer.
<table>
<thead>
<tr>
<th>MONDAY</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>07:00AM - 08:00AM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>08:00AM - 09:15AM</td>
<td>MCB 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>09:30AM - 10:45AM</td>
<td>BSC 1085 - 39276</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>10:45AM - 11:00AM</td>
<td>* OFFICE *</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>11:00AM - 01:30PM</td>
<td>MCB 1000L - 40938</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>01:30PM - 02:00PM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TUESDAY</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>07:00AM - 09:30AM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>09:30AM - 10:45AM</td>
<td>BSC 1086 - 39302</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>11:00AM - 12:15PM</td>
<td>BSC 1085 - 39274</td>
<td>YADM 214</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>12:15PM - 01:00PM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>01:00PM - 03:30PM</td>
<td>BSC 1085L - 39346</td>
<td>YADM 202</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WEDNESDAY</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>07:00AM - 08:00AM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>08:00AM - 09:15AM</td>
<td>MCB 1000 - 40893</td>
<td>YADM 214</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>09:30AM - 10:45AM</td>
<td>BSC 1085 - 39276</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>10:45AM - 11:00AM</td>
<td>* OFFICE *</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>11:00AM - 01:30PM</td>
<td>BSC 1085L - 39300</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>01:30PM - 02:00PM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>THURSDAY</th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>07:00AM - 09:30AM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>09:30AM - 10:45AM</td>
<td>BSC 1086 - 39332</td>
<td>YADM 205</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>11:00AM - 12:15PM</td>
<td>BSC 1085 - 39274</td>
<td>YADM 214</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>12:15PM - 01:00PM</td>
<td>* OFFICE *</td>
<td>YFAC 211</td>
<td></td>
</tr>
<tr>
<td>08/24/05 - 12/13/05</td>
<td>01:00PM - 03:30PM</td>
<td>BSC 1085L - 39302</td>
<td>YADM 202</td>
<td></td>
</tr>
</tbody>
</table>

If you are unable to meet me at the posted office hours, please contact me for additional hours that are available by appointment.

Faculty: ____________________ Dean: ____________________

Note: If faculty are assigned to sections with no meeting days assigned, (primarily for Distance Learning sections), the report will currently exclude these sections in the output. (A modification to the current custom report has been submitted to OIT to include sections with no meeting days assigned.) A temporary solution is to key in meeting days (without meeting times) on SOFF (Section Offering screen) for the section (MTWTHF, for example).
Entering Grades in HawkNet

It’s that time of year again! Time to assign grades to your students at the end of a term? Here’s a set of simple instructions that describes how to enter grades on your own in HawkNet/WebAdvisor 3.0 (online student system).

1. Point your browser (Internet Explorer, Firefox) to the HCC Home Page
2. Click on the HawkNet link under the pictures

Click this link to search and/or register for classes, view your grades, and access your educational records
3. Click the HawkNet - WebAdvisor link to continue.

Log In

User ID: trogal
Password: ********
Show Hint:  

SUBMIT

4. Click the Logon tab or icon on the top right of the page.
5. Enter your User ID and password in the text boxes provided.
6. Click the Submit button to continue.
7. Click the <Grading> link in the right side “Faculty Information” area.

8. The next screen is to logon as an instructor with your User ID and password.
9. Click inside the User ID text box and enter your User ID
10. Tab to or click inside the Password text box and enter your Password.
11. Click the Submit button to continue.
12. A screen will display that asks you for which term you would like to assign grades. This is done by using the drop down box in the middle of the page that says “Term” like the sample below.

13. For this sample we will use the Fall Term of 2005.

14. Once your choice is made, click the Submit button.

15. You will be presented with a full size screen that shows all the course sections you are teaching for that term.
16. Choose the one for which you would like to assign grades by placing a checkmark in the box to the left of the class like the sample below.

17. Click the Submit button to continue. A large screen will appear with some helpful Hints and your instructor information - check for accuracy and continue scrolling down on the page.
18. The middle section of the screen has a grid-like structure with a list of all the students currently registered for your class.

19. There will be two text entry boxes for each student.

20. Place your cursor in (and click) the very first box under the one entitled “Grade” for grade student.

21. Type in the grade you wish to assign. It may be any of the following:

   **A, B, C, D, F, FX** (failure for excessive absences),
   **I** (Incomplete), **N** (for Prep courses only)

22. There are spaces for two letters, but enter only one of the grades from those listed above (the only one using two spaces is the FX grade).

23. To move from one grade entry box to the next - entitled “Last Attend Date.” You can click the TAB button on your keyboard twice or place your cursor (and click) directly in the next grading text box.

24. **DO NOT ASSIGN A W GRADE!** These are entered by the system after a student has dropped a class online or by an admissions office clerk. This student should NOT appear on the grade assignment list at all.
25. **DO NOT ENTER A “LAST ATTEND DATE” UNLESS YOU ENTER AN <FX> GRADE** *(The FX grade is assigned to a student who stops going to class rather than attending sporadically.)*

26. Once you have entered all the grades for your students in this class, press the Submit button to actually let the system assign your grades.

27. If everything is done correctly, you will get a confirmation page that resembles the screenshot below.

<table>
<thead>
<tr>
<th>Student</th>
<th>ID</th>
<th>Grade</th>
<th>Credits</th>
<th>CEUs</th>
<th>Expiration Date</th>
<th>Last Attend Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Fish, Biggie G.</td>
<td>0596961</td>
<td>F</td>
<td>3.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Fish, Junior</td>
<td>0596967</td>
<td>A</td>
<td>3.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Fish, Padrooga F.</td>
<td>0596969</td>
<td>FX</td>
<td>3.00</td>
<td></td>
<td>10/14/05</td>
<td></td>
</tr>
<tr>
<td>4 Rogal, Patches F.</td>
<td>0596965</td>
<td>C</td>
<td>3.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 Swatches, Fish N.</td>
<td>0596960</td>
<td>I</td>
<td>3.00</td>
<td></td>
<td>03/07/06</td>
<td></td>
</tr>
</tbody>
</table>

28. Notice that while the text boxes are gone from the screen and the grades and date you entered for the FX grade have been entered for you.

29. **NOTE: DO NOT ENTER THE “LAST ATTEND DATE” FOR THE INCOMPLETE GRADE!** The system will enter the Expiration Date of that I grade for you automatically based on end date of the term for the class.

30. Remember, the following message must appear for your grades to be entered and assigned properly:

   This page is a confirmation that your grades have been recorded in the on-line system. If this page does not show the grades you submitted, the grades were not recorded. Please review for accuracy. If correct, print, sign and date, and submit to your academic dean.

This completes the task of entering grades for one class section. If you have another class section to grade, you may go back to the original Menu screen by clicking the Menu link near the bottom right hand side of the screen. You can also check out the Frequently Asked Questions (FAQ) section. If this completes your work, you should Log Out of HawkNet by clicking on the Log Out link at the bottom right hand side of the page.

This concludes this documentation on Faculty Info Screens. If you have any problems or further questions, please contact: Maridru Clark (253-7082) mclark@hccfl.edu